KODAK mc3 Portable Multimedia Device
User’s Guide

Congratulations on your purchase of a new KODAK mc3 Portable Multimedia Device. With the mc3 device you can:

- Play MP3 files.
- Take video clips with audio.
- Take digital still pictures.
- Use the color LCD to preview videos and pictures before you take them, and to review videos and pictures after you take them.
- Add pictures and videos to a document or Web page.
- E-mail your pictures and videos to friends.

Visit Kodak on the World Wide Web at www.kodak.com
Table of Contents

1 Getting Started .............................................1
- Preparing to Use the mc3 Device ................................ 1
  - Attaching the Wrist Strap ...................................... 1
  - Loading the Batteries ......................................... 2
  - Inserting a Picture Card ..................................... 3
  - Removing a Picture Card .................................... 4
  - Turning the mc3 Device On and Off ............................. 5
  - Low Battery Icon .............................................. 6
- Sleep Mode ..................................................... 6
- Customizing the mc3 Device .................................... 7
  - Setting the Sound Preferences ................................. 8
  - Setting the Date and Time ................................... 9
  - Setting Video Out ............................................ 10
  - Setting the Language ......................................... 11
  - Formatting a Picture Card ................................... 12
  - About the mc3 Device ......................................... 13

2 Playing Internet Music ........................................ 15
- Obtaining MP3 Music Files ..................................... 16
- Playing Music .................................................. 17
- Adjusting Playback Options .................................... 18
3 Taking Videos ............................................. 21
   Taking a Video ......................................... 22
   Understanding Status Icons ............................. 23
   Using QuickView with Videos ......................... 24
       Reviewing a Video During QuickView ............... 24
       Deleting a Video During QuickView ............... 25
       Reviewing a Video After QuickView Ends ......... 25
   Changing Video Quality Settings ..................... 26

4 Taking Pictures .......................... 27
   Taking a Picture ...................................... 28
   Using QuickView With Still Pictures ................. 29
       Deleting a Picture During QuickView .......... 29
       Reviewing a Picture After QuickView Ends .... 30
   Using the Self-Timer .................................. 31

5 Reviewing Pictures and Videos .......... 33
   Deleting Pictures and Videos ....................... 34
   Setting Up a Slide Show ........................... 36
6 Installing the Software ................................. 39

Installing Software on a WINDOWS-Based Computer .... 41
  System Requirements .................................... 41
  Installing Software for the KODAK mc3 ............... 42
  Installing the mc3 as a Device for RealJukebox ....... 43

Installing Software on a MACINTOSH Computer ....... 44
  System Requirements .................................... 44
  Installing mc3 MACINTOSH Software ................. 45

7 Working With Music, Video, and Picture Files ......... 47

Connecting to a Computer, Television, or Stereo ...... 48

Transferring Files to a WINDOWS-Based Computer ..... 49
  Using a Picture Card Reader ......................... 50
  Using the WINDOWS Open Browser .................. 51
  Using a Third-Party Application .................... 52

Transferring Files to a MACINTOSH Computer ......... 53
  Using a Picture Card Reader ......................... 54
  Using a Third-Party Application .................... 55

Locating Files on a Picture Card ...................... 56
  How Files are Named ................................. 57
  How Pictures and Videos are Numbered ............... 57

Renaming Files Transferred to the mc3 Device ........ 59
1 Getting Started

Preparing to Use the mc3 Device
Before using the KODAK mc3 Portable Multimedia Device, you need to:
- Attach the wrist strap.
- Load the batteries.
- Insert a KODAK Picture Card.

Attaching the Wrist Strap
Attach the wrist strap to carry the mc3 device.

1. Thread the short loop of the wrist strap through the recessed post.
2. Thread the long end of the wrist strap through the short loop. Pull until secure.
Loading the Batteries

Three AAA-size batteries are included with the mc3 device, so you can get started immediately.

1. Slide the battery door, located on the bottom of the device, so it flips open.
2. Insert the batteries as indicated inside the battery compartment.
   The single battery is inserted (+) end first; the two other batteries are inserted (-) end first.
3. Press down on the battery door. Slide it until it locks in place.

NOTE: Because digital devices are demanding on batteries, keep an extra set of batteries handy.

Consider purchasing a KODAK Ni-MH/Ni-Cd Battery Charger with KODAK Ni-MH Rechargeable Batteries, available as an accessory through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.

For guidelines on safe battery usage, see “Using Batteries Safely” on page 76.
Inserting a Picture Card

The mc3 device comes with a KODAK Picture Card, which stores your pictures, videos, and music. The Picture Card (also known as a CompactFlash or memory card) is removable, reusable, and x-ray safe.

**Important:** Use only certified Picture Cards that carry the CompactFlash logo. KODAK Picture Cards are available as an accessory through a dealer of KODAK products, or from our Web site at http://www.kodak.com/go/accessories.

1. After ensuring that the mc3 device power is off, open the Picture Card door.

2. Hold the Picture Card by the end that has a raised lip that you can feel with your fingers. This lip should face the back of the device. The opposite end of the Picture Card (with tiny holes) should face into the card slot.

   **CAUTION:** The Picture Card can only be inserted one way; forcing it may damage the card or mc3 device.

3. Slide the Picture Card into the card slot. When it is flush with the side of the device, push it firmly. The eject button (above the Picture Card) pops out.

4. Flip the eject button down. Close the Picture Card door.
Removing a Picture Card

1. Open the Picture Card door.
2. Flip the eject button up, then firmly press it with your fingertip.
   *The Picture Card partially slides out.*
3. With your fingernail under the lip, pull the Picture Card from the card slot. Then close the door.

**Important:** Do not eject a Picture Card while the video recording time remaining is blinking on the LCD; you could lose your video.
Turning the mc3 Device On and Off

After you have inserted the batteries and a Picture Card, turn the device on.

1. Press the Power button.
   *The Power Indicator LED lights up.
   *The LCD displays an image or other information.*

2. To turn the mc3 device off, press the Power button again.
   *The device completes any tasks it is performing before it shuts off.*

---

[Diagram of the mc3 device showing the Power Button and Power Indicator LED.]
Low Battery Icon

When battery power is low, a battery icon is displayed on the LCD. If no battery icon is displayed, your batteries have enough power to run the mc3 device.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No icon is displayed on the LCD</td>
<td><strong>OK</strong> - Batteries are charged and ready for use.</td>
</tr>
<tr>
<td><img src="image" alt="Battery icon" /></td>
<td><strong>Low</strong> - Batteries may need to be replaced or recharged soon, but there is sufficient power to use the device.</td>
</tr>
<tr>
<td>Power LED is flashing</td>
<td><strong>Exhausted</strong> - Batteries are too weak to power the device. The device will not operate until you replace or recharge the batteries.</td>
</tr>
</tbody>
</table>

Sleep Mode

If the mc3 device senses no activity for an extended time, it enters “Sleep” mode to conserve battery power. To awaken the device from Sleep mode, press the Shutter button halfway down.

If the device is allowed to remain in Sleep mode, it will eventually turn off.

Press the Power button to turn the device back on.
Customizing the mc3 Device

Using the Settings submenu, you can:

- Choose sound preferences
- Choose a language
- Set date and time
- Format a Picture Card
- Set video out
- View information about the mc3 device

Find information on mode-specific settings in these chapters:

<table>
<thead>
<tr>
<th>To Adjust Settings Specific To</th>
<th>Such As</th>
<th>See Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="music.png" alt="Music" /></td>
<td>Equalizer, Repeat, Shuffle</td>
<td>“Playing Internet Music” on page 15</td>
</tr>
<tr>
<td><img src="camera.png" alt="Camera" /></td>
<td>Video quality (Good and Best settings)</td>
<td>“Taking Videos” on page 21</td>
</tr>
<tr>
<td><img src="camera.png" alt="Photo" /></td>
<td>Self-Timer</td>
<td>“Taking Pictures” on page 27</td>
</tr>
</tbody>
</table>

**NOTE:** If you remove the batteries from the device for an extended period of time, or if the batteries become exhausted, you may need to reapply a setting.
Setting the Sound Preferences

You can set the mc3 device to these sound preferences:

<table>
<thead>
<tr>
<th>Selected</th>
<th>Confirmation sounds are played when:</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>A picture is taken</td>
</tr>
<tr>
<td></td>
<td>A video is started and stopped</td>
</tr>
<tr>
<td>All On</td>
<td>All the above, and</td>
</tr>
<tr>
<td></td>
<td>When any valid button is pressed (except the Power button)</td>
</tr>
<tr>
<td>All Off</td>
<td>No sounds</td>
</tr>
</tbody>
</table>

To change the sound setting:

1. The Mode selector may be in any position. Press the Menu button. The settings for that mode are displayed.
2. Press the buttons to highlight the Settings submenu. Then press the Select button.
3. Press the buttons to highlight the Sound icon, then press the Select button. The Sound settings are displayed.
4. Press the buttons to highlight the desired setting. Press the Select button to save the setting.
Setting the Date and Time

The mc3 device displays the date and time in a 24-hour format. To set or adjust the date and time:

1. The Mode selector may be in any position. Press the Menu button.
   *The settings for that mode are displayed.*

2. Press the buttons to highlight the Settings submenu. Then press the Select button.

3. Press the buttons to highlight the Date and Time icon, then press the Select button.
   *The date and time settings are displayed.*

4. Press the buttons to adjust the year, then press the button.

5. Repeat Step 4 for the month, day, and time.

6. When finished, press the Select button to save the setting.
Setting Video Out

If you want to display pictures and videos on a television or video monitor (using an optional KODAK AV Cable), the Video Out feature needs to be correctly set.

The mc3 device is compatible with NTSC or PAL video signals. The NTSC format is used in most countries, including the United States. PAL is generally used in European countries.

1. The Mode selector may be in any position. Press the Menu button.

2. Press the buttons to highlight the Settings submenu. Then press the Select button.

3. Press the buttons to highlight the Video Out icon, then press the Select button.

4. Press the buttons to highlight the desired setting. Press the Select button to save the setting.

Accessories are available through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.
Setting the Language

To change the language setting:

1. The Mode selector may be in any position. Press the Menu button. *The settings for that mode are displayed.*

2. Press the buttons to highlight the Settings submenu. Then press the Select button.

3. Press the buttons to highlight the Language icon, then press the Select button. *The Language settings are displayed.*

4. Press the buttons to highlight the desired setting. Press the Select button to save the setting. *The Settings submenu is displayed.*
Formatting a Picture Card

If you have a Picture Card that has been used in another digital device, the card may not be properly formatted for the mc3 device.

**Important:** The Format Picture Card function erases the contents of the Picture Card and prepares the card for use in the device.

1. Ensure that a Picture Card is in the device. The Mode selector may be in any position. Press the Menu button.

   *The settings for that mode are displayed.*

2. Press the buttons to highlight the Settings submenu. Then press the Select button.

   *Press the buttons to highlight the Format Picture Card icon, then press the Select button.*

   *The Format Picture Card menu is displayed.*

3. Highlight Continue Format, then press the Select button.

   *The Formatting Card screen is displayed until the Picture Card is formatted.*
About the mc3 Device

You can view information about your mc3 device, including:

- Current firmware version
- Total number of pictures taken
- Total number of video clips taken

1. The Mode selector may be in any position. Press the Menu button. The settings for that mode are displayed.

2. Press the buttons to highlight the Settings submenu. Then press the Select button.

3. Press the buttons to highlight the About icon, then press the Select button. The About screen is displayed.

4. When finished, press the Menu button. A screen similar to this is displayed.
2 Playing Internet Music

Your KODAK mc3 Portable Multimedia Device is a full-featured MP3 player! With the mc3 device and its powerful software you can:

- Extract MP3 files from a music CD that you already own, or download music from the Internet.
- Create, edit, and delete playlists.
- Play music through headphones or through a computer.
- Play music through a home, portable, or car stereo using an optional stereo cable or cassette adapter.

Accessories are available through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.

For important MP3 information, See “Disclaimer” on page 73.
## Obtaining MP3 Music Files

After you have loaded the software that is included with the mc3 device (see “Installing the Software” on page 39), you can transfer MP3 music to the device using any of these methods:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Method</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINDOWS</td>
<td>WINDOWS Explorer</td>
<td>Use standard WINDOWS functionality. See “Using the WINDOWS Open Browser” on page 51.</td>
</tr>
<tr>
<td></td>
<td>RealJukebox Software</td>
<td>See “Installing Software for the KODAK mc3” on page 42</td>
</tr>
<tr>
<td></td>
<td>A device such as a card reader</td>
<td>See “Using a Picture Card Reader” on page 50</td>
</tr>
<tr>
<td>MACINTOSH</td>
<td>“Copy To” method</td>
<td>Choose MC3 &gt; Copy To MC3</td>
</tr>
<tr>
<td></td>
<td>A device such as a card reader</td>
<td>See “Using a Picture Card Reader” on page 54</td>
</tr>
</tbody>
</table>
Playing Music

To play an MP3 music file from a Picture Card, slide the Mode selector to the Music position.

<table>
<thead>
<tr>
<th>To</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll through songs</td>
<td>Press one of the buttons.</td>
</tr>
<tr>
<td>Scan information on songs</td>
<td>Press and hold one of the buttons.</td>
</tr>
<tr>
<td>Play or pause</td>
<td>Press the button.</td>
</tr>
<tr>
<td>Stop</td>
<td>Press the button.</td>
</tr>
<tr>
<td>Restart the current song or to</td>
<td>Press and release one of the buttons.</td>
</tr>
<tr>
<td>skip to the next</td>
<td></td>
</tr>
<tr>
<td>Fast forward or rewind a song</td>
<td>Press and hold one of the buttons.</td>
</tr>
<tr>
<td>Adjust the volume</td>
<td>Press the (+) or (-) buttons.</td>
</tr>
<tr>
<td>Listen privately</td>
<td>Plug in headphones.</td>
</tr>
</tbody>
</table>

**NOTE:** Use your computer software to edit the order of a playlist.

To connect the mc3 device to a computer, television, or stereo, see “Connecting to a Computer, Television, or Stereo” on page 48.
**Adjusting Playback Options**

You can adjust music settings to your preferences.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![](image) | **Equalizer**  
Adopts low-, mid-, and high-range frequencies to give best playback for these types of music:  
- Pop  
- Rock  
- Jazz  
- Classical  
- Voice |
| ![](image) | **Repeat**  
Repeats entire playlist until the Stop button is pressed, or until the Mode selector is changed to another mode. |
| ![](image) | **Shuffle**  
Plays MP3 files within a playlist in random order. |
To change the music settings:

1. Slide the Mode selector to the Music icon.
2. Press the Menu button.
3. Press the buttons to highlight the Equalizer, Repeat, or Shuffle setting, then press the Select button.
4. Press the buttons to adjust the setting, then press Select to apply the new setting.
Taking Videos

Use your KODAK mc3 Portable Multimedia Device to take and share videos with sound. Just switch the device to the Video setting and get ready to take great videos!

You can:
- Use the color LCD as a live viewfinder.
- Use the QuickView feature to review a video you just took, then choose to keep or delete it.
- Adjust the video quality setting for desired results.
- Attach a tripod.

You can take approximately:

<table>
<thead>
<tr>
<th>Seconds of Video</th>
<th>Per</th>
<th>Using This Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>1 MB of Picture Card storage</td>
<td>Best</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>Good (ideal for e-mail)</td>
</tr>
</tbody>
</table>
Taking a Video

To take a video:

1. Set the Mode selector to the Video position. *The LCD displays a live image.*

2. Press the Shutter button all the way down, then release the button. *The LCD displays “REC” and the recording time remaining on the Picture Card.*

To stop taking a video, press the Shutter button again.
Understanding Status Icons

While you are capturing a video, one or more of these status messages or icons will be displayed on the LCD:

<table>
<thead>
<tr>
<th>Display</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality Setting</td>
<td>☑ Quality icon — Indicates Best quality setting (320 x 240 pixels; 20 frames per second)</td>
</tr>
<tr>
<td></td>
<td>☑ No icon — Indicates Good quality setting (320 x 240 pixels; 10 frames per second)</td>
</tr>
<tr>
<td>10:15</td>
<td>The video time remaining is displayed in minutes and seconds.</td>
</tr>
<tr>
<td>.00</td>
<td>There is no room left on the Picture Card.</td>
</tr>
<tr>
<td>Battery</td>
<td>See “Low Battery Icon” on page 6.</td>
</tr>
</tbody>
</table>

NOTE: Because actual resolution and compression may vary according to subject, time remaining may decrease in a nonuniform manner.
Using QuickView with Videos

When you are finished taking a video, the LCD displays the last frame of the video and a trash can icon for five seconds. If you want to keep the video, take no further action; the video is saved on the Picture Card.

Reviewing a Video During QuickView

<table>
<thead>
<tr>
<th>Action</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play or pause a video</td>
<td>Press the [/] button</td>
</tr>
<tr>
<td>Stop a video</td>
<td>Press the [] button</td>
</tr>
<tr>
<td>Fast-forward or rewind</td>
<td>Press and hold one of the buttons</td>
</tr>
<tr>
<td>Restart the video</td>
<td>Press and release the button</td>
</tr>
</tbody>
</table>

| Volume Controls         | Adjust the volume     |
| Headphone Jack          | Press the (+) and (-) buttons on top of the device |
| Listen privately        | Plug in headphones    |
Deleting a Video During QuickView

1. While the trash can icon is displayed, press the Select button.
   *The LCD displays the Delete screen.*

2. Press the ▲/▼ buttons to highlight YES.

3. Press the Select button to apply the selection.
   *The device returns to Video Capture mode.*

Reviewing a Video After QuickView Ends

1. Press the button.
   *The LCD displays the last frame of the most recent video and the trash can icon.*

2. Review or delete the video, or wait until the QuickView ends.
Changing Video Quality Settings

You can choose between two video quality settings:

- **Best**: 20 FPS (frames per second); 320 x 240 pixels
- **Good**: 10 FPS; 320 x 240 pixels (ideal for e-mail)

**NOTE**: Videos taken with the Best setting will take up more space on the Picture Card.

To change the Quality setting:

1. With the Mode selector in the Video position, press the Menu button. *The LCD displays the Video menu.*
2. Highlight the Video Quality icon; then press the Select button.
3. Press the direction buttons to highlight a Quality selection. Press the Select button to apply the setting.

To return to Video Capture mode, press the Menu button.
4 Taking Pictures

The KODAK mc3 Portable Multimedia Device makes taking pictures easy and fun! Just set the device to the Picture setting, and you are on your way to capturing great pictures. You can:

- Use the color LCD to frame your subject before you take a picture.
- Use the QuickView feature to review a picture you just took, then choose to keep or delete it.
- Set the Self-Timer to put yourself in a picture.
- Use the tripod mount to attach to a tripod.

You can take approximately 10 pictures for each MB of Picture Card storage.
Taking a Picture

Taking pictures with the mc3 device is a snap! The color LCD acts as a viewfinder, so you can see what a picture looks like before you take it. You can take a picture as close as 2.3 feet (0.7 meters).

1. Slide the Mode selector to the Pictures position.
   *The LCD displays a live image and approximate number of pictures remaining. (The Self-Timer icon appears if the Self-Timer is turned on. The battery icon appears if battery power is low.)*

2. Compose the picture using the LCD.

3. Press the Shutter button all the way down.
   *The picture is stored on the Picture Card.*

4. Wait approximately 5 seconds before taking another picture.
Using QuickView With Still Pictures

QuickView lets you review or delete a picture immediately after it is taken. After you take a picture, the LCD displays that picture and a trash can icon for five seconds. If you want to keep the picture, take no further action; the picture is saved on the Picture Card.

Deleting a Picture During QuickView

1. While the trash can icon is displayed, press the Select button.  
   *The LCD displays the Delete screen.*

2. Press the buttons to highlight YES.

3. Press the Select button to delete the picture.  
   *The device returns to Picture mode.*
Reviewing a Picture After QuickView Ends

1. Press the \( \text{button} \).
   *The LCD displays the most recent picture and the trash can icon.*

2. Delete the picture, or wait until the QuickView ends.
Using the Self-Timer

When you set the Self-Timer and press the Shutter button, the mc3 device waits 10 seconds before taking the picture. This lets you get into the picture!

1. Move the Mode selector to the Pictures position. Press the Menu button. The LCD displays the Picture menu.

2. Press the buttons to highlight the Self-Timer icon. Then press the Select button.

3. Press the buttons to highlight ON, then press the Select button. The new Self-Timer setting is shown next to the Self-Timer icon.

4. Press the Menu button. The Self-Timer icon appears at the top of the LCD.

5. Place the device on a tripod or firm support. Compose the picture using the LCD. Press the Shutter button all the way down, and then move into the picture. The Self-Timer icon blinks until the picture is taken. If sounds are turned on, the device also “beeps” during this time.
Canceling the Self-Timer

The Self-Timer feature is turned off after a picture is taken. To cancel the Self-Timer selection before a picture is taken, do any of the following:

- Turn off the mc3 device.
- Slide the Mode selector to change to a different mode.
- Press the Shutter button a second time. (A picture will not be taken, but the device remains in Self-Timer mode.)
5 Reviewing Pictures and Videos

The KODAK mc3 Portable Multimedia Device lets you show off your pictures and videos to your friends, as well as delete unwanted pictures or videos.

1. Slide the Mode selector to the Review position. The most recent picture or video is displayed. Pictures and videos are numbered. Videos are designated by the Video Camera icon.

2. Use the buttons to scroll through pictures and videos.

   - To play or pause a video, press the button. To stop, press the button.
   - To restart the current video, or skip to the next video, press and release one of the buttons.
   - To fast forward or rewind a video, press and hold one of the buttons. To adjust the volume, press the (+) and (-) buttons on the top of the device.

To run a slide show of pictures and videos, see “Setting Up a Slide Show” on page 36.
Deleting Pictures and Videos

The mc3 device lets you delete pictures and videos that you no longer want. You can delete one or all of your pictures and videos.

Deleting a Picture or Video During Review Mode

There are two ways to delete pictures and videos in Review mode; the first is much like during a QuickView.

1. Slide the Mode selector to the Review position.
   *The most recent picture or video is displayed.*
   *Pictures and videos are numbered, and videos are designated by the Video Camera icon.*

2. Use the buttons to locate the picture or video you wish to delete.
   *The trash can icon is displayed for 5 seconds.*

3. To delete the video, press the Select button while the trash can icon is displayed.

4. Follow the prompts to confirm the deletion.
Deleting All Pictures and Videos

Using the Menu button, you can delete some or all pictures and videos:

1. With the Mode selector in the Review position, press the Menu button.
   
   The Review menu is displayed.

2. Use the buttons to highlight the trash can icon, then press the Select button.
   
   The Delete menu is displayed.

3. Use the buttons to highlight one of these choices:
   - This Picture
   - Exit (without deleting anything)
   - All Images

4. Press the Select button to apply the selection.
Setting Up a Slide Show
You can set up a slide show to view pictures and videos continuously:

1. With the Mode selector in the Review position, press the Menu button.
   *The Review menu is displayed.*
2. Highlight the Slide Show icon, then press the Select button.
   *The Slide Show Interval menu is displayed.*
3. Press the ▲/▼ buttons to designate the number of seconds to display each picture. (Videos are not affected by this setting.)
4. Press the Select button to apply the setting.
   *The slide show begins automatically and ends after the last picture or video is displayed.*

You can run the slide show on a television. See “Television or stereo: Use a KODAK AV Cable (optional accessory),” on page 48 for details. (A television connection requires an optional KODAK AV Cable.)
**Controlling a Slide Show**

Use these buttons to control the slide show:

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press</td>
<td>/</td>
<td>Pause or resume the slide show</td>
</tr>
<tr>
<td>Press</td>
<td>◀▶</td>
<td>Display the previous or next picture or video</td>
</tr>
<tr>
<td>Press and hold</td>
<td>◀▶</td>
<td>Fast-forward or rewind a video</td>
</tr>
<tr>
<td>Press</td>
<td>■</td>
<td>End the slide show</td>
</tr>
</tbody>
</table>
6 Installing the Software

Included with your KODAK mc3 Portable Multimedia Device is software that lets you use the pictures, videos, and music files that you store on the Picture Card.

For WINDOWS-based computers (see page 41):

<table>
<thead>
<tr>
<th>Software Package</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>KODAK mc3 Connection Software</td>
<td>Provides mc3 drivers and the mc3 Connection application</td>
</tr>
<tr>
<td>APPLE QUICKTIME 4 for WINDOWS</td>
<td>Plays mc3 videos</td>
</tr>
<tr>
<td>RealJukebox</td>
<td>Plays and records digital music</td>
</tr>
<tr>
<td>RealJukebox Plug-in and Skin</td>
<td>Downloads MP3 files and the mc3 RealJukebox Skin</td>
</tr>
</tbody>
</table>

For MACINTOSH computers (see page 44):

<table>
<thead>
<tr>
<th>Software Package</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>KODAK mc3 MACINTOSH Software</td>
<td>Provides mc3 drivers and the mc3 Connection application</td>
</tr>
<tr>
<td>APPLE QUICKTIME 4</td>
<td>Plays mc3 videos</td>
</tr>
<tr>
<td>MUSICMATCH Software</td>
<td>Plays and records digital music</td>
</tr>
</tbody>
</table>
For both WINDOWS-based and MACINTOSH computers:

<table>
<thead>
<tr>
<th>Software Package</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADOBE ACROBAT Reader</td>
<td>For displaying PDF files</td>
</tr>
<tr>
<td>ARCSOFT VIDEOIMPRESSION</td>
<td>Software For creating, animating, and editing desktop videos using video, audio, and image files</td>
</tr>
<tr>
<td>ARCSOFT PHOTOIMPRESSION</td>
<td>Software For viewing and editing pictures</td>
</tr>
</tbody>
</table>

Information on using the software can be found in the online help supplied with each software application.
Installing Software on a WINDOWS-Based Computer

System Requirements

- WINDOWS 98/SE, WINDOWS ME, WINDOWS 2000
- Personal computer with PENTIUM 90-MHz microprocessor (minimum; 266-MHz is recommended) and CD-ROM drive
- Color display monitor with 256 color (High Color 16-bit or True Color 24-bit recommended)
- 32 MB or more of available RAM (64 MB or more is recommended)
- A minimum of 70 MB of hard disk space available
- Available USB port or CompactFlash card reader
Installing Software for the KODAK mc3

These software packages are necessary to enjoy the full KODAK mc3 experience on your computer:

<table>
<thead>
<tr>
<th>Software Package</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>KODAK mc3 Software</td>
<td>Provides mc3 drivers and the mc3 Connection application</td>
</tr>
<tr>
<td>QUICKTIME 4 for WINDOWS</td>
<td>Plays mc3 videos</td>
</tr>
<tr>
<td>RealJukebox</td>
<td>Plays and records digital music</td>
</tr>
<tr>
<td>RealJukebox Plug-in and Skin</td>
<td>Downloads MP3 files and the mc3 RealJukebox Skin</td>
</tr>
</tbody>
</table>

1. Close all other software programs before loading the software. If you are not sure which applications to shut down, consult the computer or software manufacturer for details.

2. Place the software CD into the CD-ROM drive.
If Auto Play is enabled, the first install window automatically appears. If the first install window does not automatically appear, choose Run from the Start menu. In the Run dialog box, type the drive letter that contains the CD and type \setup.exe. For example: d:\setup.exe

3. Follow the on-screen instructions to install all software. (Install the RealJukebox plug-in after you install RealJukebox. Also see “Installing the mc3 as a Device for RealJukebox” on page 43.)

   NOTE: During installation, take a moment to fill out and send the product registration card. This entitles you to information on software updates and registers some of the bundled products. (You may also use the online registration form.)

4. Restart the computer after installing KODAK mc3 Software.
Installing the mc3 as a Device for RealJukebox

1. Start the RealJukebox application and then choose Tools > Install Device.
2. In the Preferences dialog box, click the Devices/Storage tab and then click Add.
3. In the Add Devices/Storage dialog box, select KODAK mc3 and then click OK.

   The Preferences dialog box shows KODAK mc3 in the Installed Devices list.

   To further configure transfer options (optional):
   - Select Kodak mc3 from the Installed Devices list.
   - Click Configure on the Devices/Storage card of the Preferences dialog box.
   - In the Configure KODAK mc3 dialog box, select the desired file transfer and quality options and click OK.

4. In the Preferences dialog box, click OK to close the window.

   You are now ready to use RealJukebox with the mc3 device.
Installing Software on a MACINTOSH Computer

System Requirements

- MACINTOSH operating system 8.6 through 9.0.4
- PowerPC-based MACINTOSH computer with CD-ROM drive
- Color display monitor with minimum resolution of 640 by 480 (1024 by 768 preferred) and 256 colors (Thousands or Millions recommended)
- 32 MB or more of available RAM (64 MB is recommended)
- A minimum of 70 MB of hard disk space
- Available USB port or CompactFlash card reader
Installing mc3 MACINTOSH Software

These software packages are necessary to enjoy the full KODAK mc3 experience on your computer:

<table>
<thead>
<tr>
<th>Software Package</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>KODAK mc3 MACINTOSH Software</td>
<td>Provides mc3 drivers and the mc3 Connection application</td>
</tr>
<tr>
<td>APPLE QUICKTIME for MACINTOSH</td>
<td>Plays mc3 videos</td>
</tr>
<tr>
<td>MUSICMATCH Software</td>
<td>Plays and records digital music</td>
</tr>
</tbody>
</table>

1. Place the software CD into the CD-ROM drive.
   *The browser launches automatically. (If it does not launch, double-click the mc3 CD icon, then double-click the Start icon.)*

2. If prompted, restart the computer when the software installation is complete.

*NOTE:* During installation, take a moment to fill out and send the product registration card. This entitles you to information on software updates and registers some of the bundled products. (You may also use the online registration form.)
Working With Music, Video, and Picture Files

You can connect your KODAK mc3 Portable Multimedia Device and:

- Play Internet music on a stereo (using optional AV Cable).
- Present pictures and videos on a television (using optional AV Cable).
- Edit pictures, videos, and audio on a computer.

You can transfer your music files, videos, and pictures from the mc3 device to a computer by using the USB cable (supplied).

You will want to transfer your media files from the mc3 device to your computer to:

- Enjoy best video playback performance
- View pictures
- Play music files on your favorite MP3 player
- Keep files secure on your hard disk
- Free up space on your Picture Card

You can also transfer files from your Picture Card to a computer using an optional card reader, such as the KODAK USB Picture Card Reader, available through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.
Connecting to a Computer, Television, or Stereo

**USB computer:** Use the USB cable (provided).

1. Place the mc3 device on its front.
2. Plug the appropriate end of the USB cable into the port on the bottom of the device.
3. Plug the other end of the USB cable into an open USB port on the computer.

*The mc3 device automatically turns on.*

**MACINTOSH OS:** An mc3 icon appears on the desktop.

**WINDOWS OS:** An mc3 icon appears in the My Computer or Explorer window. The mc3 Connection Software launches.

**Television or stereo:** Use a KODAK AV Cable (optional accessory).

1. Plug the appropriate end of the TV Cable into the video out port on the bottom of the device.
2. **TV/VCR:** Connect the RCA audio plugs (red and white) and the video plug (yellow) to the audio and video in jacks on the TV or VCR.

**Stereo:** Connect the RCA audio plugs to the audio in (left and right channels) jacks on the stereo. (Use a cassette adapter to play music through a car stereo.)
Transferring Files to a WINDOWS-Based Computer

When you connect the mc3 device to your computer, the application window displays the contents of the Picture Card in KODAK mc3 view. The application window provides the work space for:

- Viewing thumbnails of pictures stored on the Picture Card
- Transferring pictures, music, and videos to your computer
- Deleting music, videos, and pictures
- E-mailing pictures and videos
- Printing your pictures
- Launching other music and editing applications

You can also use the application window to view the contents of the C:\Kodak Pictures\mc3 Inbox folder, which was created when the software was installed and stores the pictures, videos, and music files you transfer to your computer from the Picture Card.

Accessing Help

To access online help, choose Help > KODAK mc3 Software Help.
Using a Picture Card Reader

In addition to connecting your mc3 device to the computer to get your media files, Kodak provides two optional accessories to help you get your media files.

- CompactFlash Card Reader is a mouse-sized card reader that can greatly decrease the time to transfer your media files from the mc3 device to your computer.

Accessories are available through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.

To Get Media Files Using a Card Reader

1. In the My Computer window, right-click the card reader icon or the PCMCIA drive icon, and choose Open or Explore from the context menu.
2. If you are using the Open browser, open the folder on your hard disk where you want to transfer the media files and then position the folder so you can see the Open window.
3. Do either of the following:
   - **Music files**: Double-click the MUSIC folder.
   - **Still pictures or video clips**: Double-click the DCIM folder and then double-click 100__MC3 folder.
4. Select the files you want and drag them to the folder opened in step 2.

To listen to a music file, play a video clip, or view a still picture in the destination folder, double-click the file. The file is opened in the default application registered to open files of that format. In mc3 Inbox view, you can drag a file to the linked application designated to open files of that format.

**NOTE:** For best on-screen viewing of your media files, set your monitor display to High Color (16-bit) or True Color (24-bit).
Using the WINDOWS Open Browser

To transfer media files using the Open browser:

1. In the My Computer window, do the following:
   - Open the folder on your hard disk where you want to transfer the media files and then position the folder so you can see the My Computer window.
   - Double-click the KODAK mc3 icon.

2. Do either of the following:
   - **Music files**: Double-click the MUSIC folder.
   - **Still pictures or video clips**: Double-click the DCIM folder and then double-click 100__MC3 folder.

3. Select the files you want and drag them to the folder opened in step 1.
   To listen to a music file, play a video clip, or view a still picture in the destination folder, double-click the file. The file is opened in the default application registered to open files of that format. In mc3 Inbox view, you can drag a file to the linked application designated to open files of that format.

**NOTE:** For best on-screen viewing of your media files, set your monitor display to High Color (16-bit) or True Color (24-bit).
Using a Third-Party Application

You can open media files stored on the Picture Card using any third-party application that supports and/or is registered to open MP3 music files, QUICKTIME video clips, or JPEG pictures.

To register a file format and associate an application with it, choose View > Options from the My Computer window and then click the File Types tab. For more information, see the WINDOWS Help.

Opening a Media File in a Third-party Application

1. Transfer files from the mc3 device to your computer using mc3 Connections Software or WINDOWS Explorer.
2. Using the Third-Party media application (such as ARCOFT VIDEOIMPRESSION), choose File > Open.
3. Navigate to the folder where the transferred file resides, and select the file.

NOTE: For best on-screen viewing of your media files, set your monitor display to High Color (16-bit) or True Color (24-bit).

The music files are copied to the mc3 device. When the files are successfully transferred, the Transfer Status column indicates On Device.

For more help with software, choose Help > KODAK mc3 Software Help.
Transferring Files to a MACINTOSH Computer

You will want to transfer your media files from the mc3 device to your computer to:
- Enjoy best video playback performance
- View pictures
- Play music files on your favorite MP3 player
- Keep files secure on your hard disk
- Free up space on your Picture Card

When you connect the mc3 device to your computer, the device appears as an icon on your desktop.

1. Double-click the mc3 icon.
2. Double-click the appropriate folder:
   - Music files: Double-click the MUSIC folder.
   - Still pictures and video clips: Double-click the DCIM folder, then double-click the 100__MC3 folder.
3. Drag and drop the desired files to the desired location on the computer.

Accessing Help
To access online help, choose MC3 > MC3 Help.
Using a Picture Card Reader

In addition to connecting the mc3 device to a computer to get your media files, Kodak provides two optional accessories you can use to get your files.

- CompactFlash Card Reader can greatly decrease the time to transfer files from your mc3 device to the computer.
- KODAK Picture Card Adapter lets you use a CompactFlash Card in PCMCIA-ATA compatible devices. A 50-pin Picture Card (CompactFlash Card) fits in the adapter.

Accessories are available through a dealer of KODAK products or from our Web site at http://www.kodak.com/go/accessories.

1 Open the folder on your hard disk where you want to copy the files. You can use the Kodak Pictures folder to store and organize your files. To make it easier to access the Kodak Pictures folder, you can view it as a pop-up window.

2 On the desktop, double-click the KODAK mc3 icon.

3 Do either of the following:
   - Music files: Double-click the MUSIC folder.
   - Still pictures and video clips: Double-click the DCIM folder and then double-click the 100__MC3 folder.

4 Select the files you want and drag them to the folder opened in step 1. If the Kodak Pictures folder is displayed as a pop-up window at the bottom of the desktop, you can click the Kodak Pictures tab and then drag the files into the appropriate subfolder.

To listen to a music file, play a video clip, or view a still picture in the destination folder, double-click the file. You can also open files in any third-party application that supports that file format.

**NOTE:** For best on-screen viewing of pictures, set your monitor display to Thousands or Millions of colors.
Using a Third-Party Application

You can open media files stored on the Picture Card using any third-party application that supports and/or is registered to open MP3 music files, QUICKTIME video clips, or JPEG pictures.

Opening a Media File in a Third-party Application

1. Make sure the KODAK mc3 icon is on the desktop. If the icon is not on the desktop, turn off the mc3 device and then turn it on.
2. Using a third-party media application (such as ARCSOFT VIDEOIMPRESS), choose File > Open.
3. In the Open dialog box, click Desktop and then select KODAK mc3.
4. Navigate to the folder where the desired file resides. Select the file, then click Open.

For more information, see the software application’s help section.
Locating Files on a Picture Card

Music, video, and picture files are stored on the KODAK Picture Card according to a standard agreed upon by many device manufacturers.

If you use a card reader to retrieve your pictures or you cannot locate your pictures using the software, the following description of the file structure may be helpful. These folders are created when a new Picture Card is inserted in the mc3 device:

- **System folder**: A root-level folder where the mc3 firmware resides prior to an update.
- **MUSIC folder**: Contains music files.
- **DCIM folder**: A root-level folder containing the 100__MC3 folder. Each time you turn the mc3 device on or insert a different Picture Card, any empty folders within the DCIM folder are removed.
- **100__MC3**: Stores pictures and videos taken with the mc3 device.

**NOTE**: Depending on your operating system and settings, you may see the System, Music, and 100__MC3 folders displayed as SYSTEM, MUSIC, and 100__MC3 on the Picture Card.
How Files are Named

Files on the Picture Card are named as follows:

- Music files retain their original filename with the file extension MP3. Music files are stored in the MUSIC folder on the Picture Card.
- Video clips are named VID_xxxx.MOV, where xxxx represents the video clip file number and MOV indicates the file is a QUICKTIME video clip. Video clips are stored in the 100__MC3 folder on the Picture Card.
- Still pictures are named PIC_xxxx.JPG, where xxxx represents the picture number and JPG indicates that the picture is taken in the JPEG file format. Still pictures are stored in the 100__MC3 folder on the Picture Card.

How Pictures and Videos are Numbered

Pictures and videos are numbered in the order in which they are taken. For example, the first picture in the \DCIM\100__MC3 folder is PIC_0001.JPG. The mc3 device maintains a count of the number of pictures taken, which is used to determine the number of the next picture taken.

- Even if you transfer pictures or videos to the computer or delete these files from the Picture Card, the mc3 device uses consecutive numbers for all subsequent pictures. For example, if the last picture was PIC_0007.JPG, the next picture is PIC_0008.JPG.
- When you insert a different Picture Card into your mc3 device, the next number is derived by incrementing the higher of the last picture or video in the device or the highest existing number in the folder on the card.
- When you insert the Picture Card into a different mc3 device, the next picture or video number is derived by incrementing either the highest existing number or the highest number previously taken by that device.
Once you take picture PIC_9999.JPG in the `DCIM\100__MC3` folder, subsequent pictures will appear in a new folder (`DCIM\101__mc3`) on the Picture Card, beginning with picture PIC_0000.JPG.

If you use the Picture Card in a camera or device other than the KODAK mc3, and that manufacturer adheres to this file structure standard, the `DCIM` folder will contain a folder named by that camera or device. Any pictures taken with that camera or device are stored in the folder using the naming conventions established by the manufacturer.

For more information, refer to the documentation that accompanied that camera or device.
Renaming Files Transferred to the mc3 Device

WINDOWS-Based Computers

When you transfer media files to your Picture Card, the mc3 device limits the number of characters you can use in the filename to 8.3. Before you transfer a file to the device, check the filename. If it is more than 8.3 characters, either let WINDOWS software rename the file or rename the file yourself.

IMPORTANT: Do not rename media files stored on the Picture Card.

Names must follow DOS-format and can contain up to eight characters (A through Z) and numbers (0 through 9), followed by the three-character extension. You cannot use spaces or the following symbols:

- Period (.)
- Slash (/)
- Brackets ([ ])
- Semicolon (;)
- Equal sign (=)
- Quotation marks ("")
- Backslash (\)
- Colon (:
- Vertical bar (|)
- Comma (,)


MACINTOSH Computers

When you transfer music files to your Picture Card, the mc3 device limits the number of characters you can use in the filename. Before you transfer a file to the device, rename the file.

Filenames can contain up to eight characters (A through Z) and numbers (0 through 9). You cannot use spaces or the following symbols:

- Period (.)
- Slash (/)
- Brackets ([ ])
- Semicolon (;)
- Equal sign (=)
- Quotation marks (""")
- Backslash (\)
- Colon (:)
- Vertical bar (|)
- Comma (,)
### 8 Tips and Troubleshooting

If you are having trouble, check the following tables for solutions. Additional technical information is available in the ReadMe file located in the KODAK Digital Camera folder. For the latest updates to this information, visit our Web site at www.kodak.com. (Click Service and Support.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The mc3 device does not recognize a Picture Card.</td>
<td>The card may not be CompactFlash certified.</td>
<td>Purchase a certified CompactFlash Card.</td>
</tr>
<tr>
<td></td>
<td>The card may be corrupt or formatted for use in other digital devices.</td>
<td>Format the card. See “Formatting a Picture Card” on page 12.</td>
</tr>
<tr>
<td></td>
<td>A card is not properly inserted in the mc3 device.</td>
<td>Insert a Picture Card, ensuring it is firmly seated in the mc3 device. See “Inserting a Picture Card” on page 3</td>
</tr>
<tr>
<td>Cannot erase an MP3 file from a Picture Card.</td>
<td>The file may be read-only.</td>
<td>☑️ Use a card reader to delete the file or to change its attributes to read-write. (You can also accomplish this by connecting the mc3 device the computer and using the computer’s file system.) ☑️ Format the card.</td>
</tr>
</tbody>
</table>
### mc3 Device

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The mc3 device is in “sleep” mode.</td>
<td>To conserve battery power, the device goes into sleep mode if not used for an extended time. If the device still senses no activity, it shuts down.</td>
<td>Press the Menu button to awaken the device. If the device has shut off, press the Power button to turn it back on.</td>
</tr>
<tr>
<td>The Power LED flashes.</td>
<td>Battery power is too low for the mc3 device to function.</td>
<td>Replace or recharge the batteries. See “Loading the Batteries” on page 2.</td>
</tr>
<tr>
<td>A Battery icon appears on the LCD.</td>
<td>Battery power is low.</td>
<td>The mc3 device may still be used until the batteries are exhausted. Keep a fresh set of batteries (or a KODAK-specified battery charger) on hand.</td>
</tr>
<tr>
<td>When taking or deleting pictures, the number of pictures remaining occasionally skips a number, or the number does not change.</td>
<td>Image file sizes vary, depending on the content of the picture.</td>
<td>This is normal.</td>
</tr>
</tbody>
</table>
### mc3 Device

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot take a picture or video.</td>
<td>No Picture Card is installed.</td>
<td>Install a Picture Card. See “Inserting a Picture Card” on page 3.</td>
</tr>
<tr>
<td></td>
<td>Picture Card is full.</td>
<td>Either replace the Picture Card or delete pictures or videos from the card.</td>
</tr>
<tr>
<td></td>
<td>The mc3 device is writing to the Picture Card.</td>
<td>Wait until the device is finished.</td>
</tr>
<tr>
<td>During Review mode, an “Unrecognized File Format” message appears.</td>
<td>Pictures from a KODAK or other digital camera may be on the Picture Card.</td>
<td>The device displays only those file formats that it recognizes.</td>
</tr>
<tr>
<td>A video clip skips during playback on mc3 device.</td>
<td>Over time, a Picture Card may become fragmented.</td>
<td>Transfer desired music, video, and picture files to a computer. Then, reformat the Picture Card. (See page 12.)</td>
</tr>
<tr>
<td>The LCD is hard to read.</td>
<td>There is insufficient light.</td>
<td>Sufficient light is needed for reflective LCD.</td>
</tr>
<tr>
<td>An e-mailed Video File cannot be read by recipient.</td>
<td>mc3 device videos are saved in MOV file format. Recipient must have APPLE QUICKTIME.</td>
<td>Download QUICKTIME (free of charge) from <a href="http://www.apple.com">www.apple.com</a>.</td>
</tr>
</tbody>
</table>
## LCD Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Picture Card Full     | There is not enough room on the Picture Card to take another picture or video, or to copy a music file. | Do any of the following:  
  - Replace the Picture Card.  
  - Switch to Review mode and delete unwanted pictures or videos.  
  - Switch to Music mode and delete unwanted music files.  
  - If trying to take a video clip, change to a lower Quality Setting. |
| Insert Picture Card   | There is no Picture Card in the mc3 device.                           | Insert a Picture Card into the device.                                   |
| Picture Card Unreadable | The mc3 device cannot access the Picture Card.                        | Either format (see “Formatting a Picture Card” on page 12) or replace the current Picture Card. |
### mc3 Device Communications

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>An error message states that the computer cannot find the mc3 device.</td>
<td>The device is not connected to the USB cable, or the cable is not connected to the computer USB port.</td>
<td>Connect the cable to the device and the computer port. See “Connecting to a Computer, Television, or Stereo” on page 48.</td>
</tr>
<tr>
<td>Some laptops turn off ports to conserve energy.</td>
<td></td>
<td>See the Power Management section of the laptop’s documentation to disable this feature.</td>
</tr>
</tbody>
</table>

### Computer or Monitor

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A video clip skips during playback on a computer.</td>
<td>Playback quality is determined by a computer’s processor, hard drive, memory, and video card.</td>
<td>Adjust the monitor display settings. Refer to the computer’s documentation for more information.</td>
</tr>
<tr>
<td>The image on your monitor is jagged or inappropriately colored.</td>
<td>The monitor may not be set correctly.</td>
<td></td>
</tr>
</tbody>
</table>
9 Where to Get Help

If you need help with your KODAK mc3 Portable Multimedia Device, it is available from a number of resources:

- Chapter 8 “Tips and Troubleshooting”
- Place of purchase
- Software manufacturer

Software Help

To obtain help with the software packaged with the mc3 device, use the online help or contact the manufacturer of the software. To access KODAK mc3 online help:

- MACINTOSH: Choose MC3 > MC3 Help
- WINDOWS: Within the KODAK mc3 Connection application, choose Help > KODAK mc3 Software Help

Online Services

Get information from Kodak via:

- America Online: (keyword) KODAK
- CompuServe: GO KODAK
- World Wide Web: http://www.kodak.com (click the Service and Support link)
Faxed Information
Kodak offers automated support by fax:
- U.S. and Canada: 1-800-508-1531
- Europe: 44-0-131-458-6962
- U.K.: 44-0-131-458-6962
Warranty and Regulatory Information

Limited Warranty
Kodak warrants the KODAK mc3 Portable Multimedia Device to be free from malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original sales receipt; dated proof of purchase is required for warranty coverage.

Warranty Replacement Coverage
This warranty will be honored within the geographical location that the product was purchased.
Kodak will REPLACE the KODAK mc3 Portable Multimedia Device if it fails to function properly during the warranty period, subject to any conditions and/or limitations stated herein. Such replacement is the sole remedy under this warranty. If it is necessary to replace the entire product, it may be replaced with a remanufactured product.
Limitations

Warranty service will not be provided without dated proof of purchase, such as a copy of the original dated sales receipt.

This warranty does not apply to the batteries used in this device. This warranty does not cover circumstances beyond Kodak’s control, nor problems caused by failure to follow the operating instructions in the user’s guide.

THIS WARRANTY DOES NOT APPLY WHEN FAILURE IS DUE TO SHIPPING DAMAGE, ACCIDENT, ALTERATION, MODIFICATION, UNAUTHORIZED SERVICE, MISUSE, ABUSE, USE WITH INCOMPATIBLE ACCESSORIES OR ATTACHMENTS, FAILURE TO FOLLOW KODAK’S OPERATION, MAINTENANCE OR REPACKING INSTRUCTIONS, FAILURE TO USE ITEMS SUPPLIED BY KODAK (SUCH AS ADAPTERS AND CABLES), OR CLAIMS MADE AFTER THE DURATION OF THIS WARRANTY.

Kodak makes no other express or implied warranty for this product. In the event that the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the purchase date. The option of replacement is Kodak's only obligation. Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of this product, regardless of the cause. Liability for any special, consequential or incidental damages (including but not limited to loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services, or claims of your customers for such damages resulting from the purchase, use or failure of the product), regardless of cause or for breach of any written or implied warranty is expressly disclaimed and excluded herefrom.
Your Rights
Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. This warranty gives you specific rights; you may have other rights, which vary from state to state or by jurisdiction.

Outside the United States
In countries other than the United States, the terms and conditions of this warranty may be different. Unless specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.

Software Application Support
For application specific support, contact your reseller, systems integrator, software manufacturer, or dealer.

How to Obtain Service

When returning the device, use the original packaging materials. Enclose a problem report with the device. If the original packaging has been discarded or is not available, packaging will be at the owner’s expense.

Unless a specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no other warranty or liability exists beyond the
information contained above, even though defect, damage or loss may be caused by negligence or other act.

To obtain warranty service, contact your local Kodak service representative.

**Regulatory Information**

**FCC Compliance and Advisory**

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 1) this device may not cause harmful interference, and 2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed or used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: 1) reorient or relocate the receiving antenna; 2) increase the separation between the equipment and the receiver; 3) connect the equipment to an outlet on a circuit different from that to which the receiver is connected; 4) consult the dealer or an experienced radio/TV technician for additional suggestions.

Any changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment. Where shielded interface cables have been provided with the product or specified additional components or accessories elsewhere defined to be used
with the installation of the product, they must be used in order to ensure compliance with FCC regulation.

**Canadian DOC Statement**

**DOC Class B Compliance**—This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set out in the radio interference regulations of the Canadian Department of Communications.

**Observation des normes-Class B**—Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe B prescrites dans les règlements sur le brouillage radioélectrique édictés par le Ministère des Communications du Canada.

**Disclaimer**

The KODAK mc3 Portable Multimedia Device is intended for personal use and enjoyment by individual users only. It is the responsibility of the user to secure the right or permission to use MP3 files. Distributing copies of MP3 files without proper authorization to do so is a violation of U.S. and international copyright laws. The device and corresponding software should only be used in accordance with applicable copyright laws.
# Appendix

## Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lens</strong></td>
<td>Focal Length: 37 mm (35 mm film equivalent)</td>
</tr>
<tr>
<td></td>
<td>Focus range: 2.3 feet (0.7 meters) to infinity</td>
</tr>
<tr>
<td><strong>Viewfinder</strong></td>
<td>Color LCD: 1.6 inch diagonal; reflective type</td>
</tr>
<tr>
<td></td>
<td>Operation: Preview at 20 FPS</td>
</tr>
<tr>
<td><strong>Image Storage</strong></td>
<td>External only (CompactFlash Type I)</td>
</tr>
<tr>
<td><strong>Power Supply</strong></td>
<td>3 AAA cells (Alkaline, Ni-Cd, or Ni-MH)</td>
</tr>
<tr>
<td><strong>Capture Modes</strong></td>
<td>Still image, still image Self-Timer, motion audio</td>
</tr>
<tr>
<td><strong>Output</strong></td>
<td>Still Image: File format: EXIF 2.1</td>
</tr>
<tr>
<td></td>
<td>Resolution: 640 x 480, 24-bit color</td>
</tr>
<tr>
<td></td>
<td>Thumbnail: 160 x 120, 24-bit color</td>
</tr>
<tr>
<td></td>
<td>Motion audio: Resolution: 520 x 240 (10 or 20 FPS)</td>
</tr>
<tr>
<td></td>
<td>Compression: MPEG4</td>
</tr>
<tr>
<td></td>
<td>Audio: Mono, 8 kHz</td>
</tr>
<tr>
<td></td>
<td>File format: QUICKTIME (.mov)</td>
</tr>
<tr>
<td><strong>Audio Player</strong></td>
<td>File Format: MP3 compatible</td>
</tr>
<tr>
<td></td>
<td>Output: Stereo through headphones or stereo line audio out from AV jack</td>
</tr>
<tr>
<td></td>
<td>(using optional AV cable)</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>Video Out: NTSC or PAL from AV jack (using optional AV cable)</td>
</tr>
<tr>
<td><strong>Host Interface</strong></td>
<td>USB</td>
</tr>
</tbody>
</table>
General Maintenance and Safety

Using Headphones Safely

- Set the volume to the lowest level before you begin listening, then carefully adjust the volume to a comfortable level.
- Once you set the volume, do not increase it. Over time, your ears adapt to the volume level. Although a volume level is comfortable, it might still damage your hearing.
- Do not listen at high-volume levels; extended high-volume listening can cause permanent hearing loss.
- Do not turn up the volume during a quiet musical passage; you might damage your hearing when a sudden, loud passage occurs.
- Do not wear headphones while operating a motor vehicle or while riding a bicycle; this can create a safety hazard and is illegal in some areas. Even though some headphones are designed to let you hear outside sounds, they still present a safety hazard.

Using Batteries Safely

- Keep batteries away from children.
- Discard used batteries according to applicable local and national regulations. Utilize established community battery recycling programs where available.
- Kodak recommends Kodak Photolife Alkaline Batteries or Kodak Ni-MH Rechargeable Batteries.
- If you elect to use alkaline batteries in the mc3 device, you will obtain better performance from “photo-flash grade” alkaline batteries, such as Kodak Photolife Alkaline Batteries. These types of batteries last more than twice as long in digital applications as ordinary alkaline batteries. Alkaline batteries are not rechargeable; do not attempt to recharge them in a battery charger.
- Remove the batteries when the device is stored for long periods of time.
- Always follow the battery manufacturer’s directions fully. Do not attempt to disassemble, short circuit, or subject the battery to high temperature or fire.
- Replace all batteries of a set at the same time. New batteries should not be mixed with used ones. Do not mix rechargeable and non-rechargeable batteries. Do not mix alkaline or Ni-MH types of batteries. Do not mix different grades or brands of batteries. Failure to observe this precaution may result in some batteries in a set being driven beyond their normal exhaust point and increase their possibility of leakage.
- NOT ALL BATTERIES ARE CREATED EQUAL. Battery life depends significantly on age, usage conditions, type, brand, and device. Not all batteries perform well under these challenging conditions. In Kodak lab tests, Ni-MH rechargeable batteries delivered outstanding results in a variety of conditions. Ni-MH batteries are designed for high-demand devices, such as digital devices, and do not exhibit the “memory” effects seen with other rechargeable technologies.
- In the unlikely event that battery fluid leaks onto your skin, immediately wash the contaminated skin with soap and plenty of water. Customers inside the U.S. can contact Kodak Health, Safety, and Environment Information at 1-716-722-5151. Customers outside the U.S. should contact their local health care provider.
- In the unlikely event that battery fluid leaks inside the device, U.S. customers can contact the Kodak Information Center at 1-800-242-2424. Customers outside the U.S. can contact their local Kodak Customer Service representative.
Maintaining the mc3 Device

- Avoid exposing the mc3 device to moisture or extreme temperatures.
- Clean the outside of the device by wiping with a clean, dry cloth. Never use harsh or abrasive cleansers or organic solvents on the device or any of its parts.
- Do not allow chemicals, such as suntan lotion, to come in contact with the surface of the device.

Cleaning the Lens and LCD Screen

Do not use cleaning solutions unless they are designed specifically for camera lenses. Do not wipe the lens or LCD screen with chemically treated eyeglass lens tissue as it may scratch the lens.

1. Blow gently on the lens or LCD screen to remove dust and dirt.
2. Moisten the lens or LCD screen by breathing lightly on it.
3. Wipe the lens or LCD screen gently with a soft, lint-free cloth or an untreated lens-cleaning tissue.
Index

A
About mc3 13
America Online 67
Appendix 75
ArcSoft
PHOTOIMPRESSION 40
VIDEOIMPRESSION 40
Attach wrist strap 1
AV cable 36, 48

B
Battery, Batteries
Charger 2
Door 2
Fluid 77
Loading 2
Low battery icon 6
Power LED 6
Using 76

C
Canadian DOC Statement 73
Cleaning 78

CompactFlash Card
Formatting 12
Full 64
Inserting 3
Not recognized 61
Removing 4
Unreadable 64
CompuServe 67
Connecting
To a computer 48
To a TV or stereo 48

D
Date and time 9
Deleting
All Pictures and Videos 35
Picture after QuickView 30
Picture during QuickView 29
Picture in Review Mode 34
Video after QuickView 25
Video during QuickView 25
Video in Review Mode 34
Disclaimer 73
E  Equalizer 18
    Error
    Cannot find the mc3 65
    Unreadable Card 64
    Unrecognized file format 63
F  FCC Compliance 72
    File format unrecognized 63
    Firmware version 13
    Formatting a Picture Card 12
    FPS 26
H  Health 77
    Help
    Faxed information 68
    Online Services 67
    Software 67
    Where to get 67
I  Icon, Steady battery 62
    Inserting a Picture Card 3
    Installing software 39
L  Language 11
    Locating Pictures 56
M  MACINTOSH System
    Requirements 44
    Maintenance and safety 76
    Memory Card
        Formatting 12
        Full 64
        Inserting 3
        Not recognized 61
        Removing 4
        Unreadable 64
    Monitor 65
    MP3
        Disclaimer 73
        Obtaining files 16
        Player 15
        Playing music files 17
N  NTSC 10
O  Online services 67
PAL 10
PHOTOIMPRESSION 40

Picture Card
  Formatting 12
  Full 64
  Inserting 3
  Not recognized 61
  Removing 4
  Unreadable 64

Pictures
  Locating 56
  Taking 27

Playback Options 18

Playlist
  Repeat 18
  Shuffle 18

QuickView
  With still pictures 29
  With videos 24

ReadMe 61
RealJukebox 16

REC 22
Rechargeable 2
Regulatory information 69
Repeat playlist 18
Reviewing Pictures, Videos 33

Safety 76
Self-Timer 31
Service 71

Changing 7
Date and time 9
Language 11
Playback 18
Sound 10
Video out 10
Video quality 26
Shuffle playlist 18
Sleep mode 6
Slide Show 36
Software
   Help 67
   Installing 39
   mc3 49, 53
   Support 71
Sound Settings 10
Specifications 75
Strap, wrist 1

Taking
   Pictures 27
   Videos 21
Timer 31
Tripod 31
Troubleshooting 61

Using batteries 76

Video
   File 65
   Out 10
   Quality settings 26
   Status icons 23
   Taking 21
   VIDEOIMPRESS 40

Warranty 69
WINDOWS System Requirements 41
Wrist strap 1

Unreadable Card 64
Unrecognized file format 63
USB Cable 48

MediaCam.book Page 82 Wednesday, March 7, 2001 8:48 AM